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Component pack 2 contains new and enhanced components. It is also a cumulative release of all 
previous PSoC Creator 2.0 software. If you already installed all previous PSoC Creator 2.0 releases, then 
only the new/enhanced components from component pack 2 will be installed. Otherwise, the contents 
from component pack 1 and the complete PSoC Creator 2.0 release will also be installed, as needed. 

PSoC Creator 2.0 is a major release of the Cypress PSoC 3 and PSoC 5 device configuration 
environment. This release adds support for the Keil Microcontroller Development Kit (MDK), giving you a 
choice of firmware development environments. You can continue to use PSoC Creator for the whole 
development cycle or you can integrate into an existing firmware development flow based on the Keil 
µVision®4 Integrated Development Environment (IDE). 

PSoC Creator 2.0 installs as a separate package from PSoC Creator 1.x. This allows you to continue 
using 1.x and migrate to the new product at your own pace. We guarantee that your existing designs can 
be opened in the new software. PSoC Creator will make automatic backups of 1.x-based projects so you 
can always return to your previous setup if necessary. 

If you have technical questions visit www.cypress.com/go/support or call 1-800-541-4736 and select 8. 
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Component Pack 2 Contents 
Component pack 2 contains the following new and enhanced components. Refer to the applicable 
component datasheets (available in the PSoC Creator distribution and on the web) for additional 
information. 

New Components 
 Digital Filter Block (DFB) Assembler – The DFB is used to implement digital signal processing 

algorithms. This component provides an editor to enter the assembler instructions to configure 
the DFB block and an assembler that converts the assembly instructions to instruction words. An 
integrated simulator for the DFB is also provided with the component. 

Major Component Enhancements 
The following components have major feature additions as part of this component pack release: 

 Full Speed USB (USBFS) v2.12 – The 2.12 version of the USBFS component adds support for 
communicating with external MIDI equipment.  It also provides support for the USB device class 
definition for MIDI devices. 

 Serial Peripheral Interface (SPI) Master v2.21 – The 2.21 version of the SPI Master adds a 
High Speed Mode. This mode causes the sampling of slave data to occur after a full clock cycle 
instead of the typical SPI implementation that samples after one half clock cycle. This enables the 
SPI Master to operate at up to 18 Mbps, which is twice as fast as the standard mode. 
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Component Pack 1 Contents 
Component pack 1 contains the following new and updated components. Refer to the applicable 
component datasheets (available in the PSoC Creator distribution and on the web) for additional 
information. 

New Components 
The following new components have been added as part of this component pack release: 

 emFile File System – This component provides an interface to SD cards formatted with a FAT 
file system. The emFile file system library is licensed from SEGGER for use on PSoC devices. 
The library portion of this component must be downloaded separately from the Cypress website 
at: www.cypress.com/go/comp_emFile. 

 emWin Graphics Library – This library is an embedded graphic library and graphical user 
interface (GUI) to provide an efficient, processor- and LCD controller-independent GUI for any 
application that operates with a graphical display. The emWin graphics library is licensed from 
SEGGER for use on PSoC devices. The library must be downloaded separately from the Cypress 
website at: www.cypress.com/go/comp_emWin. 

 Resistive Touch – This component is used to interface with a 4-wire resistive touch screen. 

Major Component Enhancements 
The following component had major feature additions as part of this component pack release: 

 Filter v2.0 – The 2.0 version of the Filter component adds the capability to perform Infinite 
Impulse Response (IIR) filtering. Additionally, this version includes the ability to view and change 
the calculated coefficients for the filter. 

Updated Components 
The following components have been updated from previous versions to address various defects. Refer 
to the “Component Changes” section of each component datasheet for a description of the changes 
made. 

Component Version 

CAN v2.1 

EZI2C Slave v1.61 

Graphic LCD Control v1.61 

Graphic LCD Interface v1.61 

I2C v3.1 

SAR ADC v1.71 

Sleep Timer v2.1 

USB v2.11 

http://www.cypress.com/go/comp_emFile
http://www.cypress.com/go/comp_emWin
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PSoC Creator 2.0 Features 

Keil µVision4 IDE Integration 

PSoC Creator lets you design the perfect 8051 or ARM Cortex-M3 device. With this release, you can now 
export those designs into the Keil µVision4 IDE to write, debug, and test firmware in the development 
environment you’ve used for years. 

The Export feature supports the generation of new µVision4 projects, as well as updates to existing ones. 
You do not have to give up on those last-minute changes to the hardware or spend valuable development 
time merging code and fiddling with options. 

PSoC 5 Production Devices 

There are many changes to the PSoC 5 parts catalog in this release. We’ve qualified the silicon for 
production and removed the old ES1 parts that we were no longer sampling. We also added 20 new ones 
that you can target for real production designs. 

Static Timing Analysis 

A key element of supporting PSoC 5 production is the extension of Static Timing Analysis (STA) to this 
family of parts. STA is the methodology used by PSoC Creator to determine whether a specific design is 
able to meet the timing capabilities of the device. It is used to analyze the propagation delays in and out 
of the chip and the clocking behavior within the chip. In addition to the new devices, we’ve added support 
for hold-time analysis and extended temperature range parts. 

Timing-Driven Routing 

Timing-driven routing (TDR) is a build-time feature that incorporates timing constraints into the routing 
algorithm. This helps reduce the number of STA violations in digital designs and reduce the variability of 
routing solutions (where a small design change has a disproportionate impact on routes found). The new 
routing algorithm not only recognizes timing problems but re-routes designs to avoid them. 

Annotation Wires and Terminals 

You can now configure the Pins component to show an annotation terminal. This is a new type of 
connection for off-chip components. Complementing the new feature is a comprehensive library of 
annotation components, such as resistors, capacitors, diodes, and power supplies. Use these 
components to document your PSoC schematics with the board-based features of your design. We’re 
already using annotation components in our Application Notes and Code Examples on the web. Look for 
the new content in the Component Catalog. 

Concept Components 

In addition to our usual library of components, we've added some concept components to the Component 
Catalog. These components range from handy point solutions that solve problems in all kinds of designs 
up to sophisticated hierarchical solutions for specific applications. They were developed by our 
Applications team, who work on customer designs and address real-world problems. 

You should feel free to try these components in your designs, and take them to production if they are a 
good fit for you. However, be aware that they have not been validated to the same quality standards as 
our regular content.  
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Component State Reporting 

To make sure you are aware of the level of content maturity, we have implemented a component state 
reporting feature. All concept components, as well as versions of our standard components distributed in 
beta releases, are “watermarked” in schematics. There is also a gentle reminder in the Notice List window 
that they are "Prototype," as opposed to “Production” components. 

Live Start Page 

When we introduced PSoC Creator, we populated the Start Page with information about the new devices 
and an introduction to the tool. In order to provide more up-to-date information, we've made the Start 
Page Internet-enabled. We’ll be publishing weekly news updates for topics such as PSoC kits, software 
updates, application notes and code examples, fun competitions, trade shows, training courses, online 
webinars, and more! 

Multi-Application Bootloading 

The bootloader now supports loading of applications to multiple spaces in flash. This can be used to 
ensure that a usable image is always available. If, for example, a new image starts to download (which 
normally overwrites the current image) and the interface becomes unavailable, the alternative application 
can continue to be used until the hardware failure can be addressed. 

Design Impact 

Migration to Production PSoC 5 Devices 

PSoC Creator 2.0 supports production-qualified PSoC 5 devices. For help updating projects that target 
ES-marked (engineering sample) PSoC 5 devices, refer to Migrating to PSoC® 5 Production Devices. 
This document is located on disk in the installation "documentation" folder and online at: 
www.cypress.com/go/creator_migration. 

Using Projects from PSoC Creator 1.0 

Because this is a major software upgrade, projects saved in PSoC Creator 2.0 cannot be opened in 1.0 
versions of the tool. As a result, if you open and save an older project in PSoC Creator 2.0, you will no 
longer be able to open it in the older software. To enable safe software updates, PSoC Creator 2.0 
automatically creates an archive (zip file) of the original project in a backup folder inside the project 
directory. 

Support for PSoC 3 ES2 Devices Closing 

This is the final release of PSoC Creator to support the ES2 (engineering sample 2) revision of PSoC 3 
devices. The next minor release (that is, PSoC Creator 2.1) will require projects to be re-targeted to 
production devices. Use the Device Selector (from the Project menu) to switch from the “ES” part to the 
production alternative. 

Migration from Obsolete Devices 

Some pre-production (engineering sample) PSoC 3 and PSoC 5 devices have been made obsolete now 
that the devices are in production. All projects that target these part numbers must be migrated to new 
parts. On opening the project, PSoC Creator 2.0 will prompt you with the logical alternative part number. 

http://www.cypress.com/go/creator_migration
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You are free to accept the suggestion or open the Device Selector and choose an alternative. For more 
details, refer to the PSoC® Creator™ 2.0 Migration Guide. This document is located on disk in the 
installation "documentation" folder and online at: www.cypress.com/go/creator_migration. 

Symbol Changes for Cypress Components 

To add functionality, it was necessary to update the symbols of every component. Specifically, Cypress 
components now display a watermark for Prototype and Obsolete versions. In addition, a new property 
was added to components to identify a landing page on the Cypress web site. If the property is set by the 
component author, there will be menu items to open a web browser to the URL provided. 

Rather than adding an uninformative and repetitive note to all patched component datasheet change logs, 
we made these changes silently. The implementations were not changed and the behavior of patched 
components is unaffected. 

Auto-Clocks May Solve Differently 

For PSoC Creator 2.0, the auto-clock mechanism has been optimized to prefer a 50% duty cycle. As a 
result of this change, local (auto) clocks in PSoC Creator 1.x projects opened in version 2.0 may be 
assigned to different sources. For example, a clock solved using the PLL in a previous version, may be 
solved using the IMO in PSoC Creator 2.0 (if both satisfy the frequency and tolerance expectations of the 
local clock). 

If you want to maintain how local clocks were solved in the previous version of the tool, open the project 
in PSoC Creator 1.x. Observe how the clock was solved in the Design-Wide Resources Clock Editor. 
Then, manually configure the clock as appropriate. 

Clocks configured with explicit sources in a previous version will not be altered in PSoC Creator 2.0. 

Supported Devices 

The design flow and tools available in PSoC Creator 2.0 support the following PSoC 3 (CY8C3x) and 
PSoC 5 (CY8C5x) families of devices: 

PSoC 3: CY8C32* CY8C34* CY8C36* CY8C38* 

PSoC 5: CY8C52* CY8C53* CY8C54* CY8C55* 

Supported Toolchains 

Toolchains for PSoC 3 (8051) 

1. DP8051 Keil™ 9.03 

The Keil PK51 Professional Developers Kit for PSoC is installed with PSoC Creator. It supports 
optimization levels 0 through 5. If you would like to use the compiler optimization levels above 
level 5, you should purchase the standard PK51 compiler by contacting Keil. 

 In North, Central, or South America... sales.us@keil.com 
 In Europe, Asia, Africa, or Australia... sales.intl@keil.com 

The free toolchain comes with a 30 day evaluation license. You can extend the license, without 
cost, by registering the product from within PSoC Creator (Help > Register > Keil…). Note that 
the extended license is for one year and that you will need to re-register it upon expiration. 

http://www.cypress.com/go/creator_migration
mailto:sales.us@keil.com
mailto:sales.intl@keil.com


  
PSoC® Creator™ Release Notes 

Version 2.0 Component Pack 2 

March 15, 2012  - 7 - 

2. DP8051 Keil Generic 

This option can be used to select a separately-installed version of the Keil toolchain. While any 
version can be selected, the only officially supported versions are 8.16 and 9.03. 

Toolchains for PSoC 5 (ARM) 

1. ARM GCC 4.4.1 

The CodeSourcery Sourcery G++ Lite for ARM is installed with PSoC Creator. It has no use 
restrictions and does not require license activation. It is distributed under the terms of the GNU 
Public License. 

2. ARM GCC Generic 

This option can be used to select a separately-installed version of the Sourcery G++ toolchain. 

3. ARM RVDS Generic 

This option can be used to select a separately-installed version of the ARM RealView 
Development System. The officially supported versions are 4.0 (build 529) and 4.1 (build 791). 

4. ARM MDK Generic 

This option can be used to select a separately-installed version of the ARM Microcontroller 
Development Kit. The officially supported versions are 4.0 (build 524) and 4.1 (build 713). 

Installation 

Minimum and Recommended System Requirements 

The following are system requirements to install and use PSoC Creator 2.0. Each requirement specifies a 
minimum that your system must meet or exceed. 

PSoC Creator will execute correctly in highly resource-constrained systems. However, performance 
(startup time, project creation and opening, build times, and so on) may be impacted when resources are 
scarce. The most directly impacted performance metric is build time. The following sections provide 
examples of the resource scarcity impact. 

Note During initial startup, PSoC Creator builds and caches component DLL files used to display the 
component parameter editors. As a result, the tool will launch slowly the first time after installation or a 
Windows® reboot. This is not indicative of a problem or a long-term performance degradation. 

Summary 

Hardware/Operation System Requirements Minimum 

 Processor Pentium 4 

 Processor Speed 1 GHz 

 RAM 512 MB (1 GB preferred) 

 Free Hard Drive Space 2 GB 

 Screen Resolution 1024x768 

 USB 2.0 
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Software Prerequisites * Minimum Version 

 Microsoft Internet Explorer (not IE8 beta) 7  

 .NET Framework 2.0 SP1  

 Adobe Reader (for viewing PDF Documentation) 6  

 Windows Installer 3.1  

 PSoC Programmer 3.13.3  

 Keil Compiler 8.16 (9.03 provided)  

* To install and run PSoC Creator, you may also need to install additional software. The Cypress 
Installer will guide you through the process if the additional programs are not already installed. 

Processor 

An Intel Pentium 4 (or compatible), or higher, is required. The minimum processor speed is 1 GHz. 

PSoC Creator exhibits a predictable relationship between CPU speed and build time above 1 GHz. 
Doubling the CPU speed, e.g., from 1 GHz to 2 GHz or 1.5 GHz to 3 GHz, almost halves the build time. 

On a fast (3 GHz) PC, simple designs can build in about one minute. At low speeds even designs that fill 
the device and generate complex routing solutions will build in under 5 minutes. 

Operating System 

One of the following Windows platforms is required: 

 Windows XP SP2 or SP3 

 Windows Vista (32- and 64-bit supported) and SP1 

 Windows 7 (32- and 64-bit supported) and SP1 

 Mac OS X with Parallels Desktop v6 running Windows XP SP3 

Memory 

A minimum of 512 MB of RAM is required, but 1 GB is recommended. 

Note Cypress does extensive performance testing on every PSoC Creator release. The minimum RAM 
configuration used in these tests is 1 GB. No guarantees of system performance are given below 1 GB. 

With no other applications running, the minimum system configuration will ensure that the tool launches 
quickly, creates and opens projects in a few seconds, and responds to user input without feeling sluggish. 

System RAM has the most direct impact on PSoC Creator build times. The following chart shows how 
insufficient RAM (i.e., below 512 MB) causes an excessive increase in build time, even for “empty” 
designs. 
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The graph shows that performance is heavily degraded below the threshold where memory paging is 
required but extra memory above that level does not generate a significant improvement. 

Free Disk Space 

PSoC Creator requires 2 GB of free disk space. 

PSoC Creator will install and run with just 1 GB of free disk space. However, in order to allow Windows to 
do memory paging, we also require at least as much free disk space as you have RAM in your system, 
resulting in a minimum free disk space requirement of 2 GB. 

If your disk is highly fragmented it will severely impact memory paging time and can result in very long 
build times. Disks that are nearly full are particularly prone to fragmentation. We recommend de-
fragmenting your disk If you experience excessively long build times (10 minutes or more). 

USB 

PSoC Creator requires a USB 2.0-compliant host to program and debug. 

Screen 

A resolution of 1024x768 pixels or higher is required. 

Note The build time examples given above were obtained with new product installations on minimally 
fragmented disks with no other applications running. If your build times exceed these expectations we 
recommend closing unnecessary applications, adding RAM to the system (to reduce paging) and 
ensuring that there is sufficient free and unfragmented disk space. 

Software Update Instructions 

As part of the installation process, the Cypress Update Manager utility will also be installed and located 
on the Start menu. You can use this utility to update all programs you have installed when updates for 
them become available. 
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Open Source 

Portions of this software package are licensed under free and/or open source licenses such as the GNU 
General Public License. Such free and/or open source software is subject to the applicable license 
agreement and not the Cypress license agreement covering this software package. The applicable 
license terms will accompany each source code package. You may obtain the source code of such free 
and/or open source software at no charge from the following web site: www.cypress.com/go/opensource. 

Installation Notes 

The installation process is a set of wizards that walk you through installing various components. You can 
install PSoC Creator and various prerequisites from the web or from a CD. There are slight differences in 
the process, based on the medium used to install the software. 

The CDs provide the necessary prerequisites and the wizards to guide you through installing the 
appropriate software. The following sections contain more specific installation details. 

Note Do NOT plug in your Miniprog3 until all software installation is complete AND the PSoC Creator 
application has been opened. 

PSoC Creator CD Installation 

The PSoC Creator CD contains PSoC Creator and PSoC Programmer, as well as various prerequisites.  

1. Load the CD. The main installer program should run automatically. If not, double-click the 
cyautorun.exe file to launch it. 

2. On the main installer, click the Install Software for PSoC… button to launch the PSoC Creator 
InstallShield Wizard. 

3. Follow the prompts on the wizard. The CyInstaller for PSoC Creator opens and displays steps to 
install PSoC Creator.  

4. Click the hyperlink for any software that is not installed as indicated (such as, Acrobat Reader, 
etc.). Run the installer for that program as needed. 

5. Continue following the prompts to install PSoC Creator. 

Cypress PSoC Kit CD Installation 

A kit CD contains PSoC Creator and PSoC Programmer, as well as projects, documentation, and 
prerequisites needed for the associated kit. Refer to kit instructions. 

Web Installation 

If you are downloading the software from the web (www.cypress.com/go/creator), run the PSoC Creator 
single package executable. 

1. Double-click the PSoC Creator executable file to launch the installer. 

2. If a non-Cypress prerequisite is missing (like .Net and Windows Installer, etc), a webpage with a 
download link will pop up. Download and install the prerequisites. Run the installer of those 
programs as needed. 

3. Follow the prompts to install PSoC Creator. The CyInstaller for PSoC Creator opens and displays 
a series of steps to install PSoC Creator, and it will perform pre-requisite checks and install the 
prerequisites. 

4. When complete, close the installer. 

http://www.cypress.com/go/opensource
http://www.cypress.com/go/creator
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Further Reading 

The primary documentation for PSoC Creator is provided in the Help, which you can open from the Help 
menu or by pressing [F1]. Other documents included with this release are also available from the Help 
menu, under Documentation. These documents include (but are not limited to): 

 Quick Start Guide 

 Known Problems and Solutions (KP&S) 

 System Reference Guide 

 Component Author Guide 

The PSoC Creator KP&S document is a snapshot of the Knowledge Base issues available on online at 
the Cypress web site: www.cypress.com/go/creatoronlinekps. 

Even more information is provided online at: www.cypress.com/go/creator, including: 

 PSoC 3, PSoC 5 Architecture Technical Reference Manual (TRM) 

 PSoC 3 and PSoC 5 Registers TRM 

 PSoC 3 and PSoC 5 Device Datasheets 

 Migration Guides 

 Application Notes 

 Training 

Contact your Cypress representative, as needed. 

PSoC Creator 2.0 Defects Fixed 

The following defects were fixed in the PSoC Creator 2.0 release. These defects are separated into 
different categories. 

Framework 

Cypress ID Defect  Fix and Impact 

49573 Source based customizers aren't rebuilt when 
the project's configuration is changed from 
Release to Debug and vice versa. 

The background checker was not looking for errors in 
customizer code and so the build would fail silently. 
These errors are now correctly propagated through the 
system and reported. 

74523 No notification is given to the user that an 
analog terminal on a placed component is 
unconnected. 

While it is legal to leave an analog "input" unattached 
in a schematic, it is an unusual design situation. The 
tool now detects unconnected analog pins and reports 
note sdb.M0065 (Analog terminal <term> on 
<schematic> is unconnected). 

83001 The Keil License Registration dialog can give 
an unhandled exception when the license 
cannot be properly obtained. 

Exception handling has been added to the dialog to 
ensure useful error messages are produced when 
Internet connections are not robust. 

83865 The Find Examples dialog returns different 
search results when launched from a 
component instance and the component 
catalog. 

The defect was fixed so that the correct results are 
always returned, and the "All" selection was relocated 
to the top of the pull-down list, for convenience. 

http://www.cypress.com/go/creatoronlinekps
http://www.cypress.com/go/creator
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Cypress ID Defect  Fix and Impact 

83965 The Component Update dialog only shows 
the latest System Reference Guide as the 
cy_boot datasheet. 

All versions of the document are now shipped and the 
tool now displays the correct version of the datasheet 
(System Reference Guide). 

88227 Renaming a short-named symbol modifies 
the file extension so that the file is no longer 
recognized as a symbol. Renaming a symbol  
'c.cysym' to 'd' replaces the 'c' in the 
extension as well as the body - 'd.dysym'. 

Replaced the pattern-matching code with a simpler, 
more robust generation of the extension. This is based 
on the new name only (no string manipulation). 

88470 Updating component versions while a build is 
in progress generates a message that the 
update was successful, when in fact nothing 
changed. 

The menu is now disabled while building. 

88512 The component update tool does not show 
the instance name of a component if only one 
if present in the design. User sees only the 
component name. 

The dialog now displays the component row even if 
there is only one instance of the component on the 
schematic. 

88554 The popup menus for filtering columns in the 
Device Selector drift to the right when more 
columns are displayed. 

The calculation was being done with bounds from the 
wrong coordinate system. Pop-ups now appear in the 
right place. 

89326 Opening the component datasheet from the 
pull-right menu on an instance sometimes 
displays the wrong datasheet. 

The tool was opening the datasheet for the component 
selected in the Component Catalog, rather than the 
selected instance. It now shows the correct document. 

89363 The search field in the Component Catalog 
does not search for words in Component 
Summary 

Valid search results were missed, making it hard to 
find components whose names the user does not 
already know. Added support to search in the 
component summary. 

89566 File > Page Setup option is disabled for text 
files. 

The tool now allows page settings on text files and 
document printing code was cleaned up. 

89574 Print preview for a symbol is incorrect if page 
orientation is portrait. 

The tool now allows page settings on text files and 
document printing code was cleaned up. 

89734 When attempting to add a project with the 
same name (different directory) as an existing 
project in the workspace, the 'Pick sheet 
template' dialog opens up before project 
creation. 

Workspaces do not support two projects with the same 
name. The tool now verifies that the new project name 
is legal before creating/adding it to the workspace. 

90363 The Find Example Project dialog shows all 
available projects when actually none match 
the keyword. 

Failed searches now replace the keyword that 
generated no matches with "All", and all projects are 
listed. 

93351 Unhandled exception when creating a 
workspace bundle on machines with non-
English speaking locales. 

The archiver tool now performs floating point 
operations based on English when accessing the 
device data base, instead of the local language. 

93568 Dependencies get broken when bundling the 
system libraries in the archiver.  The resulting 
archive has some mismatched dependencies, 
and ends up pointing to the real system 
libraries, instead of the bundled copies. 

This was fixed by saving files relative to an anchor 
directory, even when that anchor directory is in the 
Cypress installation tree. 

94468 The tool generates an invalid command line 
when the Memory Layout options are used. 

The Linker/Memory Layout interface was removed. 
Users can add the commands to the command line. 
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Cypress ID Defect  Fix and Impact 

94490 Sometimes, when opening a project, a white 
window appears on the top left corner of 
PSoC Creator, covering part of the 
workspace explorer. There is no way to close 
the window without closing the project first. 

The Find dialog was erroneously adding to the PSoC 
Creator main form. This was unnecessary and has 
been resolved. 

95651 In some situations, workspaces that were 
created in previous software releases always 
generate "prj.M0170: A workspace is being 
opened in a newer version of this tool than it 
was last saved in." 

The logic that determines when and what to update 
now ensures that workspaces, as well as projects, are 
marked as updated when opened in the 2.0 release, 
so the error message will not be generated. 

96580 A library project when built with, say, the Keil 
Toolchain, gets changed to ARM GCC after 
the build. 

The toolchain edit was not marking the project as 
edited and so no save occurred (or was prompted). 
Build setting edits are now recognized and prompt a 
save. 

97134 PSoC Creator errors on a project name that 
is too long, even when it is not. The tool 
complains about the 260 character limit when 
the given (offending) path is less than that. 

The calculation was not referring to the created 
directories beneath the project directory. The error 
message now includes these extra characters and 
shows the directory name. 

97169 Renaming a project doesn't change the cydwr 
file name, and the project fails to build as a 
result. 

The rename operation now does this for projects and 
there is no longer a need to manually rename the file. 

97746 On a dual screen configuration with PSoC 
Creator running on screen 2, the debugger 
GUI clips off a significant portion of the 
mouse-over pop-up when you mouse over a 
variable. 

The code was combining screen coordinates with 
client coordinates. Added the correct conversions to 
work in a single coordinate system. 

98476 The button to clear a search in the 
Component Catalog leaves the last search 
result semi-highlighted. The green 
background is cleared but the text retains its 
white font, making it unreadable. 

The code now resets the internal counter value even if 
the search results are "old", which correctly cleans up 
the last search result highlighting. A refresh is no 
longer required to make the search item viewable 
again. 

98592 In the default Customizer dialog the 
parameter pull-down only works the first time  

In order to support the cancel-edit operation a call to 
focus on the cell was being invoked, which was 
blocking the ability to open the pull-down menu. The 
focus was only there for the case that Esc was 
pressed so the code was reworked to remove the call 
and only do it on Esc. 

99505 Creating a new project in PSoC Creator 
creates a file "device.h" which is not safe for 
multiple inclusion. 

To prevent multiple definition messages from the 
compiler, the header file uses macros to detect, and 
avoid, multiple inclusion. 

99539 Changing the source project in the Archiver 
dialog does not update the archive name. 

The dialog behavior has been corrected. It is no longer 
easy to over-write archives by mistake. 

99551 Adding a directive to a project causes all 
projects to add the directive. 

The tool now checks the project being edited and 
prevents undesired directives from being added 
silently to other projects. 

100132 Warnings and errors about the use of old 
cy_boot components fail to clear after the 
component is updated and the workspace 
closed. 

This occurs if the background DRC elaborator has not 
had time to clear the messages before the workspace 
is closed. The cache of messages is now explicitly 
cleared when a workspace is closed to ensure the 
stale messages are removed. 
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100751 When opening a datasheet from the 
schematic the tool errors with "gde.M0025: 
Cannot launch PDF reader" 

This occurred when there was no datasheet to open, 
not because of a missing reader. Added a check and 
popup for an invalid datasheet when "Open 
Datasheet" is called from schematic 

107277 Using File > New > File > Html File gives the 
error "Unable to open file from disk" 

This is because HTML files now use an external editor 
and our external editor factory refuses to create new 
instances of that file type. The HTML file type has 
been removed from the new file dialog.  

107385 PSoC Creator reports errors on component 
instances that cannot be found in the 
dependency tree for the project. If those 
dependencies are changed such that the 
component is now found, the error messages 
do not go away (project still builds). 

The background checker was looking for "shape 
changes" and has been extended to check 
dependency changes as well as schematic edits. 

109444 Editing the parameters for a buried 
component (one that is part of a component 
used in your design) can alter the behavior of 
the higher-level component in ALL user 
designs because it is silently editing the 
library project containing the component. 

The issue is that the user can silently edit the 
component implementation in a library, with the result 
that all designs using the library are impacted by the 
edit. This is particularly problematical when the library 
is part of the PSoC Creator installation. This was 
corrected by creating a lock for files saved under the 
Creator install directory. A message is displayed to 
indicate that the change is not allowed. The save 
button is disabled and any global save operations will 
fail with a message. 

110213 The print feature for schematics only fills 
roughly two thirds of the page in landscape 
mode. 

The printed image is based on a portrait layout. The 
print feature now calculates the image size based on 
the chosen orientation. 

110529 Get error prj.M0190 (There is no workspace 
open) when searching for a component 
example project. 

The error is real but the message is misleading. The 
correct message is now "No example project is found". 

111338 The properties, e.g. style and end shape, of a 
line drawn on the schematic change without 
the user committing the specific edit. 

If the user changes the line color all other properties 
are reset to their default state. The tool now commits 
only the desired - line color - edit. 

Editors 

Cypress ID Defect  Fix and Impact 

55407 Tool allows a user to choose BUS_CLK and 
MASTER_CLK frequencies that are greater 
than their sources. 

Only the PLL may have an output frequency above its 
source. Other clocks generate a DRC if their outputs 
are higher than can be attained. 

57334 PSoC Creator doesn't show every available 
IMO frequency. 

It is now possible to select any legal IMO frequency, 
as published in the PSoC 3 and 5 datasheets IMO 
frequencies. 

63088 PSoC 5 users have access to a data cache 
setting in system DWR which has no effect. 

There is no data cache on PSoC 5 devices and this 
setting has been disabled. 

75814 The "Flip Vertical" command on selections 
misplaces text in annotations. 

The command has been fixed in order to keep 
annotations the right way up and appropriately moved 
in relation to the rest of the flipped selection. 

76866 The source editor highlights some Cypress 
typedefs (which are not part of C), but not 
some types that are defined by C/C++. 

Keyword coloring was reviewed and the tool is now 
more consistent in its interpretation of keywords, 
standard defines, and so on. 
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78704 Giving a local (schematic) clock the same 
name as a pre-existing design-wide clock 
generates an assertion (crash). 

The editor now checks for name space collisions 
against other clocks. 

81208 The tool generates a spurious warning 
message related to Vref when connected to 
an analog Mux input - "pft.M0035: warning: 
Voltage Reference Warning: Vref '0.256V' is 
connected to terminal 'AoutTerm' of 'AMux_1' 
but no direct hardware connection exists." 

This message discourages the user from making a 
legal connection of the Vref to another component 
through a mux. The design-rule checker has been 
updated to "look through" the mux and determine if the 
connection is, or is not, actually possible. 

89098 Tool allows you to delete the name of a 
terminal, independently of the terminal, but 
does not create a no-name terminal. 

Symbols now check whether the delete operation is 
legal. In this case it is not because deleting a symbol 
name has no good use cases. 

89455 Local Clocks report erroneous warnings 
about IMO accuracy when it is USB mode. 

When locked to USB, the IMO is much more accurate 
(+/-0.25%) but this was not recognized by the tool, 
leading to clock warnings. Updated the clock model to 
update the report IMO accuracy whenever the USB 
was enabled to the IMO 

92580 The ILO clock accuracy at "Clocks" tab of the 
DWR file is stated as +/- 20%, which does not 
match the device spec. 

Updated the ILO clock data to match the new 
specifications. This may cause clock warnings on very 
slow local clocks that check source tolerance. 

93312 In the schematic editor, a shape with the "no 
fill" property prevents a shape beneath it from 
being selected. 

The check for IsFilled was incorrect. A context-
sensitive right-click menu was also added to enable 
the selection from multiple overlaid shape without 
affecting the z-order. 

94227 Cannot use SWV pin as GPIO in PSoC 3 
even if the feature is de-selected in the 
System DWR editor. 

The DWR now reads the SWV parameter to determine 
whether the SWV pin may be used as GPIO. 

95554 Rotating shapes in the schematic editor 
leaves the previous selection marking. 

The selection was not being updated after the rotate 
operation. That feature has been re-implemented now 
and everything is updated correctly. 

95650 When vertical-flipping the Stay Awake 
component symbol the instance name moves 
to the wrong place. 

The text class was recalculating the center to flip about 
incorrectly. 

98666 When choosing a digital signal from the 
"Select Input Signal" dialog that lets the user 
create a digital clock source from the 
schematic, expanding the node for un-named 
signals also expands other nodes. 

The issue was that bus nodes did not have an 
identifying tag and so matched every other bus node, 
causing the paired open/close behavior in the GUI. 
This has been addressed and nodes now behave 
correctly. 

98689 The rename page option in the context menu 
of Schematic editor allows renaming a page 
to an already existing page name (duplicate 
names) 

A check for name collision was added. 

103130 Design fails to build when it contains two 
ADC_DelSig components named "ADC" and 
"ADC_INT". Due to unlucky component 
naming, the ADC_INT (cy_isr) component's 
ADC_INT.c has the same name as the ADC 
(ADC_DelSig) component's ADC_INT.c API.  

PSoC Creator now checks for this type name collision 
when creating API files, not just for instance name 
collisions. 

104936 SWV pin can be used as GPIO even if 
dedicated to debug function. 

If the pin was locked before the SWV setting made the 
tool was not issuing the error. Corrected the 
background check to generate an error in this 
condition regardless of the order of events. 
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105127 Renaming a component 
(COMPONENT_NAME) when there is an 
instance placed in a schematic causes an 
infinite loop of pop-up dialogs. 

To avoid the repeating error on the mismatched 
names the tool now only checks accesses to the 
cached component data without trying to get the 
symbol header every time.  

105180 Tool does not allow USB applications, all of 
which need a 48 MHz clock, to build on 40 
MHz parts (CY8C52 family). 

The silicon allows this and the IMO, MHz, ECO and 
DSI clocks may be run at 24 MHz and through the 
doubler to provide the necessary 48 MHz for USB. 

 

Debug / Program 

Cypress ID Defect  Fix and Impact 

67029 It is not possible to update CPU register 
values via the Register Details dialog. 

Fixed an issue with the enablement of the Commit 
button in the dialog. 

100810 PSoC 3 PDATA addresses are not shown or 
updated correctly in the debugger Watch 
window. 

The PDATA memory space was not being added to 
the list of addresses the debugger translates. 

108217 The tool allows the user to set more variable 
watchpoints than the hardware can support. 

Even though the Watch and Local windows detect that 
there are no remaining watchpoints, and suitably 
disable menu options for setting them, the Source 
window still allows them to be set. The tool now uses a 
single check for available watchpoints that ensures a 
consistent enable/disable of the feature. 

110509 The radix of watched variables cannot be 
saved and preserved across debugger 
invocations. 

Changing the radix of a watched variable is not 
preserved across debugger invocations. The debugger 
now saves its state on exit. 

110543 Double-clicking a watch variable, to initiate an 
edit, causes a duplicate Watch window entry 
to be created. 

The check for a move operation is over-sensitive and 
almost any double-click action will cause a copy to be 
made in the window. The sensitivity is now correctly 
set such that a deliberate move, outside of the current 
line selection, is required to cause a move operation. 
Double-clicking on a watched variable now correctly 
enables an edit. 

110656 Cannot do a mass-copy of data from the 
debugger memory window. 

Small numbers of cells can be highlighted in the 
Memory window and copy-pasted. However, larger 
selections, where scrolling is required, fail to copy. The 
Memory window no longer resets the cursor to the first 
row when scrolling and large copies can be made from 
the window. 

 

Build System 

Cypress ID Defect  Fix and Impact 

51388 The Build Settings for the Keil 8051 compiler 
limit the optimization to level 9. 

Levels 10 and 11 are now enabled, removing an 
arbitrary restriction on the optimizer. 
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94818 GNU compiler fails to find symbols in library 
files added via the Build Settings->Linker 
dialog, causing the link to fail. 

The GNU linker does a single pass to find unresolved 
external references. In PSoC Creator, library files are 
now automatically grouped inside -Wl,--start-group 
<args> -Wl,--end-group to force the linker to iteratively 
search for unresolved references. 

94847 BitStream Verifier generates 
IndexOutOfRangeException errors in low-
resource devices. 

The placer/router was assuming the availability of 
resources that do not exist in these parts. The 
database was updated so that only real resources are 
used to route a design. 

95125 The analog hardware MUX generates 
connections that use a follower switch, which 
is not hardware controllable. As a result 
analog global routes (AGL and AGR) are 
always connected to the pin(s) and other pins 
in the physical port become corrupted. 

There are 16 switches (12 switches for opamp & 4 
switches for high current IDAC) that have direct 
connections to GPIO but not controlled by AMuxHw 
component. Code was added to the analog routing 
algorithm to limit these 16 switches from router when 
AMuxHw is in the design. 

96521 In PSoC 5 connections to the positive input of 
the ADC can get routed/shorted to the 
negative input of the ADC in the hardware. 

The amuxbusl connection from dsm0+ to dsm0- was 
the wrong way around. They have been swapped and 
the tool no longer shorts the connections. 

97222 Tool crashes while using "Additional include 
directories" if the paths listed are relative. 

Corrected the Project Management Build settings to 
allow fixed paths. 

99355 When storing configuration code in ECC 
memory, the tool fails to detect a memory 
overflow. 

The code was modified for compressed mode so that 
when the ECC space is filled it will overflow and store 
the remainder in flash. This results in it behaving the 
same was that the Uncompressed and DMA options 
behave. 

99577 When using GCC on PSoC 5, sprintf() always 
returns a string with zeros for float type 
conversion. 

A soft reset of the device does not leave the stack 
aligned properly for var arguments. This is fixed in 
cy_boot v_2_30. 

100111 When storing configuration data in ECC / 
configuration memory the bootloader 
application does not correctly validate 
application checksum before entering 
bootloadable. 

The ECC portion of the application was not being 
verified. Verification now runs over the flash and then 
runs over the ECC memory. Corruptions in either one 
will cause verification to fail. The bootloader does not 
return a status for exit, it causes the device to reset. If 
there is a valid application the application will be run. If 
there is no valid application the bootloader will start up 
again in a clean state. 

102531 PSoC Creator can generate routes to/from 
the ADC_DelSig component such that 
differential inputs are shorted. 

The device definition implied that the AMUXL bus 
connects to the positive input of the ADC (DSM block) 
and has been fixed. 

102878 CyResetStatus is not correct after a 
watchdog reset. 

The variable was pre-allocated to a specific address 
near the top of RAM that is also used for the XDATA 
stack. If any functions get called that push something 
onto the stack it would corrupt the variable value. 
CyResetStatus is now allocated an address by the 
linker. 

103102 A Logic Low connected to the OE terminal of 
an output pin does not disable the output. 

The optimizer was incorrectly removing the logic zero 
component. 
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104188 When a project is built with the 'count' input of 
a counter tied to logic 'low', the mpr.M0037 
(Removed Unused Component) warning 
message occurs. 

A counter with this input tied low will never change 
value and so the component is automatically optimized 
out of the design. The message is misleading, 
however, and has been changed to "Unused pieces of 
the design have been optimized out. See section 
<section> of the report file for details". 

104359 On PSoC 5 the PWM and Counter 
components generate a DRC, warning about 
the interrupt terminal's connectivity, when 
implemented in a Fixed Function Timer block.  

The DRC should only apply to the Timer component in 
a fixed function block. This has been corrected and the 
error message improved to help identify the offending 
component instance. 

105436 PSoC Creator can generate routes to/from 
the Comparator component such that inputs 
are shorted. 

The device definition implied that the AMUXL bus 
connects to the positive input of the Comparator and 
has been fixed. 

107256 The Cypress reentrancy file fails to set the 
reentrancy condition on generated source 
files if there is white space in the entry. 

The .cyre (reentrancy file) does not ignore white space 
and so end-of-line spaces were being treated as 
significant. White space is now trimmed. 

107455 Using a SAR_ADC in a PSoC 5 design 
prevents use of the pin that can be used for 
the bypass capacitor, even though that is not 
being used by the SAR configuration. 

The checking for associated resources was too 
restrictive on the SAR. The tool now leaves the IO 
available for other uses. 

108221 The fitter erroneously warns the user that it 
shall pick pins with pft.m0040 even though 
pins are correctly set in a control file. 

This is a potentially confusing message because it 
implies that the control file was ignored, which is not 
the case. The check for the condition has been 
delayed until after the control file is processed. 

108350 Projects migrated from GNU compiler to ARM 
MDK or RealView (RVDS) fails to reach 
main() function after reset if GNU 
compatibility mode is used (--gnu). 

The --gnu option sets both __GNU__ and 
__ARMCC__ macros. The code in cy_boot's 
CM0Start.c file was, as a result, configuring the device 
twice and hanging. The latest cy_boot component 
corrects this by ignoring the code for __GNU__ if 
__ARMCC__ is also true. 

111187 Users see erroneous errors (prj.M0038) when 
projects are dependent upon libraries on 
other network drives. 

The tool is over-zealous in marking library paths as not 
being persistent. Improved checking now allows 
libraries to be used more reliably on network drives, 
disk partitions, and USB drives. 

 

Bootloading 

Cypress ID Defect  Fix and Impact 

83802 A bootloadable project built on a new 
release is not compatible with older 
bootloaders, causing a build failure. 

Bootloader and Bootloadable projects now store 
metadata in their generated hex files to remove the 
reliance on specific directory structures. This removes 
the need for working around the problem by renaming 
the directory structure of the older bootloader project. 

105648 Bootloader projects fail to download when 
they are "large" (use many components). 

When the bootloadable image will not fit in the ECC / 
configuration memory space it is split up and some is 
placed in flash. The cyhextool was incorrectly calculating 
the end address of the application. This has been fixed 
to ensure that applications with a lot of configuration data 
will bootload correctly. 

106156 Bootloadable projects with Device Multi-App bootloaders, by definition, use significant 
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configuration mode set to "DMA" and 
having dependency to a MultiApp (Dual 
mode) Bootloader fails to build with the 
error "DMA Init must be within the first 64k 
of flash" 

amounts of flash. As a result almost all use cases require 
the flash-miserly "compressed" boot option. Also, the 
performance improvement of DMA-based configuration 
is dwarfed by the reset time and so is not useful for 
bootloading designs. To address the error, the DMA 
option with Multi-App bootloadable projects was removed 
and the default option changed from DMA to 
Compressed. Existing projects with DMA option will be 
updated to Compressed and have a warning message 
sent to the output window.   

107040 When the target devices for Bootloader and 
Bootloadable do not match, the error 
messages refer only to the mismatched 
System DWR settings. 

A new error check was added so that the user corrects 
the root issue before editing the system settings. 

109740 Bootloader applications default to the 
wrong communications interface when a 
custom set of bootloader APIs is used. For 
example, if the CyBtldrComm*() APIs are 
implemented by the user and a SPI Master 
is added to the schematic, the tool 
assumes that the SPI is the bootloader 
channel. 

The DWR lists all legal bootloader channels and defaults 
to the first one found. This is intended as a user 
convenience where the channel is automatically picked 
up. For custom bootloaders, however, this creates an 
inconsistency between the desired and the defaulted 
channel. The default channel is now always "custom" 
and the user is expected to select the desired channel in 
the DWR. 

 

System 

Cypress ID Defect  Fix and Impact 

87491 Analog components are out of spec for 
settling time when run at low voltage and the 
PGA can output incorrect voltages. 

Corrected the setting of ANAIF_CFG_PUMP_CR0 at 
low device voltage (<4 V). 

95693 PSoC Creator creates local clocks with poor 
duty cycle characteristics. 

In a system with, for example, a 3MHz IMO and 
12MHz PLL, a request for a local clock at 1MHz is 
derived from the IMO and a divider of 3. This results in 
a duty cycle of 33% whereas 50% could be achieved 
from the PLL with the same accuracy and precision. 
The clock-solver algorithm now includes a comparison 
of duty cycle (assuming 50% is ideal) as a deciding 
factor when frequency and tolerance are both satisfied 
by multiple clock sources. 

103855 Can't place a Segment LCD in a 
CY8C3245PVI-134 device. 

The internal parts database, which is used to populate 
the Device Selector, erroneously marked this part as 
having no LCD support. The database has been 
corrected and verified. 

105407 After a 48-pin part is programmed without the 
optional XRES pin disabled it cannot be re-
programmed with the Miniprog3. 

MiniProg3 only supports reset programming mode and 
so, if XRES is disabled on 48-pin parts (which do not 
have a separate, fixed XRES), it cannot re-acquire the 
part. The tool now issues a warning about disabling 
XRES on these devices and when the user clicks on 
the message the tool navigates to the DWR, enabling 
easy "correction" of the setting. 
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108735 When using the USBIO pins (P15[6]/P15[7]) 
as digital outputs (strong drive) the initial 
state is always high (1). 

Pins components that are implemented in the USBIO 
pins ignore the user's selected initial state. This is 
because USBIO default to high, whereas GPIO default 
to low. GPIO do not need to be written when the user 
wishes for a low initial value but USBIO do. The tool 
now honors the user's selection and set up USBIO 
correctly, regardless of the value. 

109084 A Pins component set to resistive pull-up 
would generate error messages for no reason 
when placed on USBIO pins. 

USBIO pins do not support resistive pull-up, only 
strong and open drain (low) are available. The tool will 
not allow placement of pins onto USBIO if the 
parameters are not supportable and the error message 
has been corrected. 

109325 Clocks based on an external 32Khz oscillator 
sometimes fail to start. 

The boot code was misinterpreting trim data for the 
XTAL_32KHZ clock source, causing boot failures. The 
boot code now correctly initializes the external crystal 
oscillator. 

109378 When using Resource Reserve components 
to force two nets to use the same routing 
resource, the tool gives the pft.M0067 error 
(There is a usage conflict for the global 
routing resource). 

There is no conflict since the reason for using the 
Resource Reserve components was precisely to force 
the nets to share resources. The message has been 
downgraded to the note apr.M0054 (The signal 
<signal> is constrained to occupy Location 
<resource>). 

109926 A Resource Constraint component, when 
applied to wire that is connected to an analog 
mux, cannot be connected to a wire that is 
constrained to use the same resource. 

The Resource Constraint fails to distinguish the Amux 
Common connection (static) from its arm connection 
(dynamic) and reports an illegal use; Resource 
Constraints for the same resource on either side of an 
analog mux. New checks have been added to identify 
which side of the mux is connected to the constrained 
route, making this a legal configuration. 

112236 Users see pft.M0000 (An internal error 
occurred in the fitter) when an input on an 
analog mux is left unconnected. 

The workaround is to make sure all "inputs" to an 
analog mux are connected. The fix in the tool ensures 
that the check for Amux connections returns a null, 
which causes the unconnected terminal to be ignored 
by the fitter. 

112370 In PSoC 5 designs it is possible to select an 
illegal voltage reference (Vref component). 

For PSoC 5 devices the following voltage references - 
Vddd, Vccd, and VBat - have been removed from the 
pull-down. Existing designs, or designs re-targeted 
from PSoC 3, that use an illegal selection will generate 
an error and the user must select a new reference. 

 

Tuning 

Cypress ID Defect  Fix and Impact 

90287 The Tuner requires the user to open the 
Configure Communications dialog before calling 
the ICyTunerCommApi_v1.Connect() API. 

It now allows a connection to be made if the settings 
are valid, so there is no need for the extra setup 
step. 

94569 After the CSD tuner helper is launched and 
used, the Miniprog3 is put into the "I2C" state. 
As a result, closing the tuner and attempting to 
re-program the device with PSoC Creator 
returns an acquisition error. 

The Select Debug Target dialog now automatically 
applies the user's MiniProg3 (or other device) 
settings when opening or attempting to program. 
This obviates the need for the user to force a re-
acquisition of the part. 
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98528 In the CyTunerProviderBase_v2  interface the 
AddressSizeBytes parameter returned is always 
32, matter what sub-address is selected (2-
bytes, 1-bytes or None) 

Corrected an issue where the tuner comm was 
returning the data for the MaxPacketSize (32) 
instead of the SubAddressSize. 

103848 The Port Configuration fields in the Tuner 
Communication Setup revert to their default 
values after a save. 

The new values are now properly (permanently) 
stored. 
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life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.  

PSoC® and CapSense® are registered trademarks, and Programmable System-on-Chip™, PSoC Creator™, and SmartSense™ are trademarks of 
Cypress Semiconductor Corporation. All other trademarks or registered trademarks referenced herein are property of the respective corporations. 

This Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by and subject to 
worldwide patent protection (United States and foreign), United States copyright laws and international treaty provisions. Cypress hereby grants to 
licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create derivative works of, and compile the Cypress Source Code 
and derivative works for the sole purpose of creating custom software and or firmware in support of licensee product to be used only in conjunction 
with a Cypress integrated circuit as specified in the applicable agreement. Any reproduction, modification, translation, compilation, or representation 
of this Source Code except as specified above is prohibited without the express written permission of Cypress.  

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATERIAL, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Cypress 
reserves the right to make changes without further notice to the materials described herein. Cypress does not assume any liability arising out of the 
application or use of any product or circuit described herein. Cypress does not authorize its products for use as critical components in life-support 
systems where a malfunction or failure may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a 
life-support systems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all charges.  

Use may be limited by and subject to the applicable Cypress software license agreement. 
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